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BEST PRACTICES COURSE – WEEK 16 – Roof Modeling & 
Documentation PART 8-A - Barrel-Vault Roofs in ArchiCAD 14 
 
Hello, this is Eric Bobrow.  In this lesson, we'll look at how you can create vaulted roofs in ArchiCAD 14 

and earlier and connect them as well to other roofs.  The reason I'm doing this in ArchiCAD 14 is that the 

methods changed radically as we moved into ArchiCAD 15, so these methods here apply to ArchiCAD 14 

and back through 10 and actually earlier.  I'm going to demonstrate here just drawing a box of walls. 

[0:00:30] 

Let's go to the Roof tool here and we'll select the method for creating a vault. You are probably used to 

creating individual roofs this way or a series of roofs.  This is in the final section where you can do both 

domes and barrel-vaults.  As I zoom in on this area here, you can see that if I click now, it starts to draw 

something.  I'm creating a roof. I don't know much about it, and going to be explaining that as I go.  The 

second click will determine the tangent line, basically how this curves.  So you can see that as I move 

around now, the tangent line was set.  You can just barely see a line there and that it's following that 

curvature.  [0:01:20] 

And perhaps I connect it to the other end here.  It's not done yet, in fact, it's waiting to see if I want to 

do another piece of roof.  And if I click again it will actually create another piece, you can see how that 

would continue.  So let me just actually click on this, and now I've got a second piece.  And I could go on 

multiple pieces if I wanted.  But I will click one extra time on this last point to finish it.  Now this has 

created a profile, and now it's saying which way is this profile going to be extruded?  I'll take it straight 

back in this case, just a little past where the building is.  [0:01:54] 

And now it says, having done and gone in that direction, how far do you want to take it out?  I will take it 

back out this way. And we'll understand what these clicks and directions are in context.  So hang in there 

with me.  So I click again to finish that extrusion and it asks, what height is this roof based on, how thick 

is it, and how are the ends dealt with? I would say OK, accepting the default.  You see that it's created a 

number of pieces of roof.  If I go to 3D here, you'll see that followed that general shape.  [0:02:27] 

It went up and then came around in the other direction just like what I drew.  Now it did it with just a 

few pieces here and so it's very crude looking.  Let me show you how you can control that.  Let me undo 

that and go to the Options menu, Magic Wand Settings.  In the magic wand settings, you can see that it 

says if you are doing an approximation, if you are tracing a curve with straight segments, how close 

should it get?  In other words, how much deviation can be allowed? If I do something where I cut this in 

half, then it's going to basically make more straight segments to get closer to the curve.  [0:03:09] 

And since roofs in ArchiCAD 14 and earlier are only made of straight segments, this will make more of 

the segments that match it better.  So now I'll do something very similar here, but perhaps I'll just click 

one more time on the end so I don't actually extend it, and then take it back to the other end of the 
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building and back again.  And I'll click OK, and you can see how it made more segments within this.  

When I go to 3D, you can see it's actually smoother.  Now if I want to control this precisely in terms of 

how many segments, perhaps I want to have a certain number there, then I can go into the magic wand 

settings, and perhaps change it from deviation to segments and long arcs. So perhaps if I wanted to have 

fifteen segments, that would give me a very smooth curve with a flat top in the middle, because I would 

have an odd number, I can choose that. [0:04:01] 

If I do this one more time, three clicks, the fourth click here, and then the fifth one back here, sixth one, 

and OK. And you can see now it has a lot of pieces. When I go to 3D you can see how they work.  Now 

these roofs here, if I wanted to adjust their height, of course I could set a different height to begin with, 

but let's say I wanted to adjust them here. I can select any one of them like this, but you see I have to 

select all of them.  This gets a little bit awkward to do that one by one.  So in this case I have no other 

roofs, so I could go to the Edit menu and say Select All Roofs. And then I would be able to go and click on 

one of them and use the pet palette to say I'd like to raise it up to a new height or position.  [0:04:48] 

I'm going to show you a way, and I'll just undo back and get rid of these, that you can actually have the 

roofs be grouped automatically.  Under the Edit menu are the grouping commands.  And under 

grouping, there's an option to auto group.  This is normally turned off in recent versions of ArchiCAD by 

default so that it doesn't accidentally cause confusion.  But if I turn that on and now I do the same sort 

of thing - actually notice when I went back to the roof that it forgot that I was drawing the vaulted roof. 

It went back to this. So let me cancel that and tell it yes, I want a vaulted roof. [0:05:24] 

So now I'm going to go do this, four clicks, the fifth one and the sixth one here. Now you see that when I 

select any one of the roofs it selects all of them.  If I go to 3D the same thing will happen.  If I select one, 

they are all grouped, and now I can of course raise them up easily here.  Now if we want to actually have 

this be a specific height, then we can do some additional work to specify that.  But before I do that, I 

want to go and select the two end walls here and make them higher.  So I'll use the pet palette to raise 

them up to some height, at least high enough that it will reach the top of this.  [0:06:12] 

And then I will use the Solid Element Operations, Design menu command, with these two walls selected 

I will make them targets and then I will select these roofs and make them the operator. Do subtraction 

with upward extrusion, execute, and you can see how we get a nice clean result.  So that's the basics of 

how you would create these roofs and trim the walls to them.  But let's go back now and be more 

specific about the heights of the roofs.  If I go to the south elevation here, we're going to see the shape 

that we've got. And perhaps I want to work with it so that it reaches a certain peak.  [0:06:57] 

In other words I may have a certain height limit or just some reason that I want to design it that way.  So 

I'll go to the Line tool, this is one way that you can measure.  I will click in the center here. And it's on a 

layer that's turned off so I will say turn that on temporarily. And let's say that I wanted it to go up to 14 

feet. So any specific distance that you need.  Now if I would like this roof to go up to that height and 
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start for example at the height of the walls here, the 10 feet, what I can do is actually draw the shape.  

So let me go to the Arc tool and draw this series of points. [0:07:32] 

And you can see it's a slightly different curvature than what I did free hand.  Now what I'm going to do is 

actually select this arc and I will copy it.  And I'm going to go back to the floor plan and paste it in.  Now 

when I paste it in, you will notice how it kept its alignment in terms of its two ends are exactly in line 

with the wall.  And I will show you what happens if we use this as a tracing template.  I'll get rid of the 

other roofs here and go to the Roof tool again and make sure that I am doing the vaulted roof. And now 

I'm going to use the magic wand.  So I'm going to use this guide to create a shape.  So I'll go and magic 

wand this and then take this up towards the back and here. [0:08:20]   

This will create a roof that will have exactly the right curvature.  However, if I go to 3D, we are going to 

see that this roof is upside down.  That's because as you may recall-and if I go back and undo this-the 

curvature was going up.  And remember how I was doing it down.  So if I want this to have the right 

curvature in this context, I can go ahead and mirror it here, and then perhaps drag it into position there.  

Now if I go to the Roof tool and have the vault selected and use the magic wand and create this, when I 

go to that elevation we are going to see that it's exactly the right curvature.  And remember, since these 

are all grouped I can just drag them up.  [0:09:15] 

You can see how precisely it's fitted to that.  In fact, I can do the same thing with a more free form shape 

or with an asymmetrical shape.  So let me go ahead and delete these roofs here and perhaps just use 

the Spline tool to make a shape here.  So I'll go to the Spline tool. And perhaps I still want to maintain 

this maximum height, so I will go and actually draw a line and use the eyedropper to pick up the Line 

tool. And I will draw a line across here and stretch it. And this line here, perhaps I'll make it a dashed line 

so we can see that it's intended to be sort of a limit. [0:09:57] 

Now I'll go to the Spline tool and I will start this. Of course I could measure it to the side any distance, 

but let's say that I wanted it to peak on this side and come down a little lower on that side.  So this 

Spline here I might adjust using the pet palette to make sure that it's not going above that point here.  I 

might need to take that down just a hair, or take this point over, something like that. So I make sure that 

it stays below that height, maximum height.  So I've now created an asymmetrical shape.  And of course 

I could play around with this until I got just the right design criteria or just the right aesthetics. [0:10:43]  

But how would we make the roof exactly the shape that we want from this?  Well remember how I 

copied this information and pasted it?  I'm going to do the same thing.  I will go and actually draw a line 

up to here.  So I'm just drawing lines on the ends here. And I will select these lines and copy this 

information.  The reason why I've got the end ones drawn in is because when I go back to the floor plan-

and we'll just go back here to the floor plan-and I paste, I'm going to say keep the original location here.  

Perhaps use this as a way of aligning it.  [0:11:30] 
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So I'm now going to be able to go and select these elements here and perhaps drag them into position.  

Now remember I mirrored before, and I could do that again, but let me actually start that roof from the 

other side.  For example, I can go to the Roof tool here and magic wand this shape.  Actually I have to 

make sure I'm in the vaulted roof again, magic wand this shape, and now you can see there's this 

extrusion vector, which I didn't really explain. Basically I'm going to go and take this down, and I can use 

the Shift key and lock it so that as I move the mouse left to right it snaps.  [0:12:12] 

I could just keep it in line and take it a little bit further here.  Now this determined the path of the roof, 

but I don't have to take it way back to here. I can just take it back for example to the end of the building 

or a little bit beyond, let's say like this.  Of course I can measure and draft that in precisely.  Let's take a 

look, since I basically have the curvature away from the building and did the extrusion vector towards 

the building, this is going to have the proper curvature.  If I go to 3D, we are going to see that it looks 

quite similar to what I had in the south elevation that I drew.  [0:12:48] 

And you can see there is that precise shape.  So if I just drag this down, say this point on top, you can see 

how it matches precisely.  So the idea is that you can draw your shape in an elevation and then copy it, 

align it nicely to the building, and use it as a guide for the magic wand.  And of course if I wanted to trim 

these walls, I can go select all the walls, go here and take them up higher, any arbitrary height as long as 

it's high enough.  Make them targets, and then go to the roof here, make it the operator and execute.  

And we now have a very beautifully clean model there.  [0:13:36] 

So now that we've looked at the ways that we can create these shapes here just by themselves, let's 

look at how we can connect a series of roofs to another roof.  So let me go and select these elements 

here, and we'll drag them over to the side a little bit.  And now I will create another little shape, these 

walls like this.  And I'll go to the Roof tool and we'll create just a hip roof around it.  So I will just magic 

wand it here.  Now suppose that we had in this sort of conventional building a couple of columns in 

front of the building, say here.  [0:14:24] 

And I'll just drag a copy over there.  And let's say we wanted a little curved piece of roof over the top of 

these two columns and extending back.  So what I'll do is go to the Roof tool here and we'll again go to 

the vault.  Now when I do this I just want to have a few pieces, I don’t want to have as many in part 

because it will be simpler to do the training.  But you can change the magic wand settings at any time.  

Let me just say that I would like to have seven pieces along this arc.  And then I will go and draw with the 

Roof tool and say from here to there and take it back and out. [0:15:10] 

So what I've done is I've just created a seven piece roof segment here.  We look at it.  It's created a nice 

curved portico entry.  But what I want to do is make sure that these segments here actually connect and 

stop where the other roof is, that they actually meet it nicely instead of being buried.  It's a little hard to 

see this, so I'm going to go to the View menu, 3D View Mode, and I'm going to go to 3D Window 
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Settings, which is a command I don't use very often.  But in this case, I want to go to the options here 

under open GL and turn off textures just to temporarily make it easier to see what going on.  [0:15:55] 

Now these roofs here, you can see there actually buried inside there.  While I could work with that, I'm 

going to go and drag this out here, and that way all the pieces are visible, the end pieces.  And now I can 

start to extend them to meet this main roof.  Now how would I do that?  Well you recall if I select a roof 

and I use the Command or Ctrl key to click on the edge of another roof, that it will actually adjust that 

edge to meet it.  Now right now, these roofs are grouped together, and if I Command or Ctrl click on an 

edge here, it's not going to do anything.  I'm actually clicking and nothing's happening.  [0:16:38] 

But if I suspend groups with this option here, then individual roofs can be selected or modified.  And 

when I Command+click or Ctrl+click on each one of these edges, and you can see I'm doing this one at a 

time, and I can also do it on the floor plan, I can select this roof and Command or Ctrl+click here. And 

you can see what it did; it actually created this curved shape.  Now if I go back to 3D, we are going to see 

how that curved shape precisely matches this roof to the other roof.  Now I took this out, I took this roof 

way out and we want to shorten it.  So what I'll do is select these.  [0:17:22] 

Now I can select them all using the Arrow tool like this, or of course I could turn groups back on, select 

one of them.  Now in order to trim it, I'm going to suspend groups again.  So even though they were 

picked in a single action, I can still edit them individually, just like I modify these individually.  And I will 

use the Split command.  This is one way that you can do it.  And perhaps I can split it across a line that I 

have figured out exactly where I want here.  You can see all of these pieces are now selected. And I can 

delete that.  For some other variations, let me just undo this.  [0:18:00] 

If I wanted to have an odd shape I could split it for example along some odd angle here and end up with 

some design that I wanted there.  Another way that we can do this here is we can use the Marquee tool. 

And with the Marquee tool draw a box around the end and click on any one of these points and move it 

into wherever I want.  And what that did was it actually made the ends of the roofs to the new point.  

Unfortunately, in terms of graphics, the pivot lines are still sticking out as long as they did.  I can turn off 

the pivot lines here, under the Onscreen View Options, but it's a little bit annoying to have that.  

[0:18:52] 

Now if you can manually go and move the pivot line in here-and that doesn't affect the roof. Basically 

the pivot line is just a theoretical line in space, and it can be as short or as long as it wants.  So perhaps 

in this case what I might want to do is instead of doing the marquee, again I will just use the Arrow tool 

and select all of these and we'll split them and draw the line in space and trim this off.  And you can see 

that these roofs, their pivot lines were trimmed when that was done, which is a nice little benefit. 

[0:19:35] 
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Now you'll notice that there's a line across here.  If I go to 3D, if we select this roof, you can see how it's 

going across.  And in fact if we orbit underneath it, you can see how it's sticking in here.  Now in some 

cases that would be the perfect choice for the design, but in other cases we might want to trim it 

around.  So what we can do is select this roof and use the pet palette option to subtract out a shape. 

And actually before we do that, I can use the Solid Element Operations and that will work beautifully in 

3D.  So let me go here in 3D, and I can select, with groups active, all of these roofs, make them the 

operator.  [0:20:21] 

They are going to control the action because I really want to modify this roof or let's say just the one 

roof. Let me suspend groups again and select just the one plane and make it the target.  And now often 

we are using subtraction with upward extrusion.  But in this case we might want to subtract where they 

intersect and everything below so that this target roof has a hole cut in it.  When I execute, you can see 

how it notched around here nicely.  And in fact as we select it we can see the shape that was created. It 

precisely matches the original or the little vault.  [0:20:57] 

And when I go back to the floor plan we still see the line because as many of you know, Solid Element 

Operations, while it modifies the 3D view of something or the 3D model it doesn't affect the floor plan.  

So what we could do is, with the Solid Element Operations in effect or not, we can actually go here and 

use the boolean subtraction and cut out a shape.  So I'm actually just clicking on the series of points that 

matched the edge of roof, these little roofs here.  You can see now this roof has been cut around. And in 

fact the Solid Element Operations are no longer even needed. [0:21:38] 

But they're not going to get in the way. But now we can see it has a natural line here.  You can see the 

nice clean line there. And if I go underneath it of course you've got this working here.  Now this wall 

here, we but want to now make it a target again and go and select these roofs. Perhaps select them 

using the Group option.  Make them the operator and trim the top of this wall like that.  And now that 

wall you can see has been notched underneath here.  You can see the little green shape that's been 

created.  [0:22:24] 

So before we conclude, I'd like to go over a couple of variations on this theme.  I will just move over to 

the side a little bit and draw another box of walls.  And then I will create a new elevation view of this 

area here.  Then in the elevation view, I'm going to go draw a more complex shape with the Spline tool 

for what I'd like the barrel-vault to look like.  So we'll create something with a little bit more complex 

curvature there.  Now I'm going to go and in order to work with this, I'm going to go and draw some 

lines so I can align this when I place it on the plan as I did before.  [0:23:21] 

But in addition to the fact that this is more complicated let's say, it's also coming from a side elevation.  

So when I select these elements and copy them and then go to the floor plan and paste, it's not going to 

actually line up properly. I'm going to put it in the center of the current view and we'll leave the current 

view alone, and you will see that it's facing up and down on the screen like it did in the elevation rather 
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than facing the direction that we need to, because it's going to be a view from the right side elevation. 

[0:23:59] 

 So what I need to do is select these lines and splines and rotate them like this, and then drag them into 

position here.  Now the important thing is that the curvature, in this case the top, is away from the 

building.  If I were to put it on the underside then we would get an under scoop. It would actually not 

work properly.  So now that I've got it facing the correct direction, I can go back to the Roof tool here 

and make sure that it's set up for the barrel-vault. And use the magic wand and then draw this down. 

[0:24:41] 

 Now I need to make sure that I'm going straight along this direction.  If I wanted to make sure that this 

was a certain specific distance beyond the edge, then what I could do is go to this corner and wait for 

the guideline to drop down, stroke along it. Now that gives me a lasting guideline. And I can go and snap 

to that intersection.  But instead of snapping directly to the face which would cut off the roof exactly in 

line with it, I'm going to make it a little bit further.  Let's say I wanted it to be 2 feet longer.  I will type in 

2, and then a +. And you'll notice how it added the 2 to the original value, and now it's exactly 2 feet 

longer than when it was along the face of the wall.  [0:25:21] 

So now I hit Enter or Return on the keyboard and that concludes placing the furthest extent exactly 

where I want it.  Now as I come back here, I can also position my mouse over the edge of the wall or the 

corner of the wall. And again it's saying that this is a certain distance horizontally or in the direction it's 

going, and I want it to be a certain distance more than that.  So again I will type in whatever distance I 

want, say 2 and a +.  And it will figure out the mathematics. And when I hit Enter, it will be exactly that 

right distance.  [0:25:55] 

Now in the vaulted roof settings here, I'll just leave this alone, except that I was working with this 

vertically. And perhaps I may want to make it a perpendicular edge.  So that would actually give me a 

little different result. We'll see what that does when I say OK.  So you can see all of the curves here that 

we've got. I will just open up that elevation. And we'll see how this has created the curvature that we 

want. I'll just select the roofs and drag the top down to this line. And you can see how beautifully this 

has matched up.  [0:26:32] 

Now with multiple curves, it's actually got a little bit too much of a difference here.  You can see how the 

straight segments are not quite matching this as well as maybe I'd like. Then what I can do is undo this 

back and perhaps change my magic wand settings here.  So instead of telling to have a certain number 

of segments along arcs and this one piece here was one arc, it made seven segments and that had a 

rather visible divergence in terms of segmentation.  Instead here with a more complex shape, I may 

want to do the deviation. And let's say ½ inch or something like, so you can experiment.  That would be - 

a half inch would be a little over 1 cm.  [0:27:25] 
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So let's just say OK and now it's set to that.  I will use the magic wand, again making sure that the roof is 

set for the vault, magic wand here and just do this by eye right now and create this. And when we look 

here in the elevation, we'll see that now it's got more pieces where it needs to. In other words, to stay 

close to that. And if I drag this down here, you can see how beautifully close that approximates it. And 

again, I chose the perpendicular one rather than vertical. You can do either vertical, perpendicular or 

horizontal for that end piece.  [0:28:09] 

If I look in 3D, you can see the shape that that created, a very nice, clean representation here.  And if I 

go back to that elevation view, you'll see that there's actually no line work across there. Even though 

each one of these is a separate little piece, ArchiCAD is merging all of those together.  Now one last 

thing.  Let me just undo back a couple steps and let's look at what happens if you were to do this roof-

and instead of going straight like this, what would happen if you were off the angle?  I just want to show 

you what that does.  [0:28:50] 

If I take this off the angle like this, say, it will take this shape and extrude it in a different direction.  So 

this particular shape now is actually high on this end compared to this one and it's going on this odd 

angle to the building.  If I go to 3D we're going to see that it's now, although the general shape is the 

same, it's been reoriented in space. And as I move around you can see that obviously it's not directly on 

top of the building.  So it does give a different effect.  So this shape can be extruded or cut through and 

moved along in any direction.  But of course the one that you would usually do would be making it 

perpendicular to the building and then drawing it in that direction. And then of course you're going to 

get something more like what you expect where we've got a high point here and a low point down there 

and we do get that section. [0:29:51] 

So this concludes our lesson on how to create vaulted roofs, barrel-vaults, in ArchiCAD 14 and earlier 

which are made with individual segments but they are made with the roof option that creates them in a 

sequence or in a group based on either a freehand sketch that you do or a magic wand of a shape.  And I 

also covered how once you've drawn these how you can connect them using that Command+click or 

Ctrl+click to basically have the main roof be the controller and each of the other little pieces be adjusted 

automatically to meet this main roof.  This has been Eric Bobrow; I look forward to reading your 

comments and questions on the page down below.  The next lesson will focus on how to do this in 

ArchiCAD 15 and later because it's actually quite a bit simpler in many ways to do it using the newer 

tools.  As I said, this has been Eric Bobrow, thanks for watching. 

[END OF AUDIO 0:30:59] 


